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Abstract

These Application Notes describe the steps necessary for configuring Session Initiation
Protocol (SIP) Trunk Service for an enterprise solution using Avaya IP Office Release 9.0 to
interoperate with Clearcom SIP Services.

The test was performed to verify SIP trunk features including basic calls, call forward (all
calls, busy, no answer), call transfer (blind and consult), conference, and voice mail. The calls
were placed to and from the PSTN with various Avaya endpoints.

Clearcom SIP Trunk Services provides PSTN access via a SIP trunk between the enterprise
and Clearcom’s network as an alternative to legacy analog or digital trunks. This approach
generally results in lower cost for the enterprise.

Readers should pay attention to section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Clearcom is a member of the Avaya DevConnect Service Provider Program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps necessary for configuring Session Initiation Protocol
(SIP) Trunk Service for an enterprise solution using Avaya IP Office Release 9.0 to interoperate
with Clearcom SIP Services.

In the sample configuration, the Avaya IP Office solution consists of Avaya IP Office (hereafter
referred to as IP Office) 500v2 Release 9.0 and various Avaya endpoints, including Avaya IP
Office Video Softphone, Avaya Flare® Experience for Windows and Avaya deskphones,
including SIP, H.323, digital, and analog.

The Clearcom SIP Trunking Service referenced within these Application Notes is designed for
business customers. Customers using this service with the Avaya IP Office solution are able to
place and receive PSTN calls via a broadband WAN connection using the SIP protocol. This
converged network solution is an alternative to traditional PSTN trunks such as analog and/or
ISDN-PRI trunks. This approach generally results in lower cost for the enterprise.

The terms “Service Provider” and “Clearcom” will be used interchangeable throughout these
Application Notes.

2. General Test Approach and Test Results

The general test approach was to connect a simulated enterprise site to Clearcom’s network via
the public Internet and exercise the features and functionalities listed in Section 2.1. The
simulated enterprise site was comprised of Avaya IP Office Release 9.0 and various Avaya
endpoints, listed in Section 4.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

To verify SIP trunk interoperability, the following features and functionalities were covered
during the interoperability compliance test:
« SIP Trunk Registration (Dynamic Authentication).
e Response to SIP OPTIONS queries.
e Incoming PSTN calls to various Avaya endpoints, including SIP, H.323, digital and
analog at the enterprise. All incoming calls from the PSTN were routed to the enterprise
across the SIP Trunk from the service provider networks.
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Outgoing PSTN calls from Avaya endpoints including SIP, H.323, digital and analog
telephone at the enterprise. All outgoing calls to the PSTN were routed from the
enterprise across the SIP trunk to the service provider network.

Incoming and outgoing PSTN calls to/from Avaya IP Office Video Softphone.
Incoming and outgoing PSTN calls to/from Avaya Flare® Experience for Windows.
Dialing plans including local calls (within Mexico), international, outbound toll-free, etc.
Caller ID presentation.

Proper disconnect when the caller abandons the call before the call is answered.

Proper disconnect via normal call termination by the caller or the called parties.

Proper disconnect by the network for calls that are not answered (with voicemail off).
Proper response to busy endpoints.

Proper response/error treatment when dialing invalid PSTN numbers.

Proper codec negotiation and two way speech-path. (Testing was performed with codecs:
G.729A, G.711A and G.711U, Clearcom’s preferred codec order.

No matching codecs.

T.38 Fax.

Proper early media transmissions.

Voicemail and DTMF tone support (leaving and retrieving voice mail messages from
PSTN phones).

Outbound Toll-Free calls, interacting with IVR (Interactive Voice Response systems).
Calling number blocking (Privacy).

Call Hold/Resume (long and short duration).

Call Forward (unconditional, busy, no answer).

Blind Call Transfers.

Consultative Call Transfers.

Station Conference.

Mobility twinning of incoming calls to mobile phones.

Items not supported or not tested included the following:

G.711 fax pass-through is not supported by Clearcom.

REFER message for call redirection is supported by Clearcom but was not tested for
reasons noted under Section 2.2.

Inbound toll-free call was not tested.

0, 0+10 digits, 411 Directory Assistance, 911 Emergency were not tested.

EC500 mobile telephone to idle-appearance FNE was not tested.
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2.2. Test Results

Interoperability testing of Clearcom SIP Services was completed with successful results for all
test cases with the exception of the observations/limitations described below.

SIP REFER: Calls from the PSTN to IP Office that are re-directed to another PSTN
endpoint by the IP Office user, with “REFER Support” enabled in IP Office (under the
SIP Line configuration in Section 5.4), did not worked properly. During call re-direction
scenarios to the PSTN, IP Office would send a “REFER” message to Clearcom,
Clearcom would respond with “202 Accepted” followed by “Notify” messages, but the
BYE messages were never received by IP Office to release the SIP Trunk resources, thus
IP Office SIP Trunk resources would remain tied up for the entire duration of the call.
Clearcom stated that their soft-switch supports REFER, and that the problem is with the
PSTN Gateways in Mexico not supporting or not allowing REFER. Testing was done
with “REFER Support” disabled in IP Office, under the SIP Line. Refer to Section 5.4.2.
Outbound Calling Party Number (CPN) Blocking: To support user privacy on
outbound calls (calling party number blocking), when enabled by the user, IP Office
sends “anonymous” as the calling number in the SIP “From” header and includes
“Privacy: id” in the INVITE message. During the compliance test, Clearcom’s network
responded with “403 PSTN calls are forbidden” to outbound calls with privacy enabled
on IP Office endpoints, resulting on the call failing to complete.

Caller ID on incoming calls from U.S. based PSTN numbers: Calls originating from
PSTN telephones based in the U.S. to IP Office displayed unrecognized numbers. During
the compliance test, Clearcom provided a local PSTN test number in Mexico, a SIP
softphone was registered to this local PSTN number and was used to originate and
terminate local PSTN calls to and from IP Office. The correct Caller ID was displayed at
the IP Office extensions when calling from this local PSTN number. This behavior is not
necessarily indicative of a limitation of the combined Avaya/Clearcom solution, this
seems to be the expected behavior for international calls from the U.S., which is
ultimately controlled by the PSTN providers, it is listed here simply as an observation.
Caller ID on outbound calls to U.S. based PSTN numbers: Calls originating from IP
Office to PSTN telephones based in the U.S. did not display the correct Caller ID. During
the compliance test, Clearcom provided a local PSTN test number in Mexico, a SIP
softphone was registered to this local PSTN number and was used to originate and
terminate local PSTN calls to and from IP Office. The correct Caller ID was displayed at
the SIP softphone when called from IP Office extensions. This behavior is not necessarily
indicative of a limitation of the combined Avaya/Clearcom solution, this seems to be the
expected behavior for international calls to the U.S., which is ultimately controlled by the
PSTN providers, it is listed here simply as an observation.

G.711 Fax Pass-Through: Clearcom only supports T.38 fax; G.711 Fax Pass-Through is
not currently supported. During the compliance test, T.38 fax interworking with G.711
did not worked properly, only T.38 fax interworking with G.729(a) worked properly.
Since Clearcom’s preferred codec order is: G.729(a), G.711A and G.711U, with G.729(a)
as the first offer, it’s expected that this issue will not have any user impact.
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e Blind Call Transfer using SIP phones do not complete until after the transferee
answers the call: When Blind Transfers are executed from Avaya 1100 Series SIP
phones the transfer does not complete until after the end user (transferee) answers the
call. Scenario: A PSTN user calls an IP Office SIP extension (Avaya 1100 Series SIP
phone), the call is answered. The IP Office user then proceeds to do a blind transfer to
another endpoint. Result: The expected behavior on the Avaya 1100 Series SIP phone is
to display “transfer completed” after answering “N0” to the question “Consultative
transfer with party?”” which implies a blind transfer. Instead, the Avaya 1100 Series SIP
phone continues to display “transferring” until the transferee answers the call. This is a
known issue with the Avaya 1100 Series phone, the work around is to hang up the SIP
phone. There is no user impact, the transfer completes successfully. This issue is only
seen with the Avaya 1100 Series phones.

e Caller ID display on Mobile station used for Mobile Twinning and Call Forwards:
For Mobile Twinning the Caller ID display at the Mobile station was of the “Host
Station” DID number in IP Office, instead of the originator of the call. For calls being
forwarded in IP Office, the Caller ID display at the terminator was also of the “Host
Station” DID number, instead of the originator of the call.

2.3. Support
For support on Clearcom systems visit the corporate Web page at: http://www.clearcom.mx/

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292)
provides access to overall sales and service support menus.
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3. Reference Configuration

Figure 1 illustrates the test configuration used for the DevConnect compliance testing. The test
configuration simulates an enterprise site with an Avaya SIP-enabled enterprise solution
connected to the Clearcom SIP trunk service through the public Internet.

The Avaya components used to create the simulated enterprise customer site includes:
e Avaya IP Office 500v2.

Avaya Voicemail Pro for IP Office.

Avaya 96x0 Series H.323 IP Deskphones.

Avaya 96x1 Series H.323 IP Deskphones.

Avaya 1100 Series SIP IP Deskphones.

Avaya IP Office Video Softphone.

Avaya Flare® Experience for Windows.

Avaya 1408 Digital Deskphones.

Avaya 9508 Digital Deskphones.

Analog Deskphone.

Fax Machines.

The enterprise site contains the Avaya IP Office 500v2 with analog and digital extension
expansion modules, as well as a VCM®64 (Voice Compression Module) for supporting VolP
codecs. The LANL1 port of Avaya IP Office is connected to the enterprise LAN (private IP
network) while the LAN2 port is connected to the public IP network. Endpoints include Avaya
96x0 and 96x1 Series IP Deskphones (with H.323 firmware), Avaya 1100 IP Deskphones (with
SIP firmware), Avaya 1408 and 9508 Digital Deskphones, Analog Deskphones, Fax Machines,
PCs running Avaya IP Office Softphone and IP Office Flare® Experience for Windows. The site
also has a Windows PC running Avaya IP Office Manager to configure and administer the
Avaya IP Office system, and Avaya Voicemail Pro providing voice messaging service to the
Avaya IP Office users. Mobile Twinning is configured for some of the Avaya IP Office users so
that calls to these user’s extensions will also ring and can be answered at the configured mobile
phones.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to make calls
across the SIP trunk to Clearcom. The short code 9 was stripped off by Avaya IP Office but the
remaining N digits were sent unaltered to the network. Refer to Section 5.5.

In an actual customer configuration, the enterprise site may include additional network
components between the service provider and the Avaya IP Office system, such as a session
border controller or data firewall. A complete discussion of the configuration of these devices is
beyond the scope of these Application Notes. However, it should be noted that all SIP and RTP
traffic between the service provider and the Avaya IP Office system must be allowed to pass
through these devices.
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For confidentiality and privacy purposes, public IP addresses, user names, passwords and
routable DID numbers used during the compliance testing have been masked.

Service Provider

'd N
PSTN
Gateway
.
Internet
T
' - SN
learcom SIP trunk Registration Simulated Enterprise
Username: User123 Domain: avaya.lab.com
Password: Password123 DIDs: 525528811241 to 1242
Domain: clearcom.mx
Public DNS: Primary:  10.5.216.122

Secondary: 10.5.153.242 g2 Enterprise Firewall

192.168.157.187

Avaya IP Office 500 V2.

Desktop PC
Avaya 96x1 Series
IP Deskphones
(H.323)

- IP Office Manager

- Voice Mail Pro Avaya 96x0 Series vaya 1100
Fax - Avaya IP Office Video IP Deskphones ASeries P
Softphone (SIP) (H.323) Desklphones
- Avaya Flare® Experience SIP
Analog  ayava 9508, 1408 4 ’ ke

\ Deskphones Digital Deskphones i
Figure 1: Avaya Interoperability Test Lab Configuration
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4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:

Equipment/Software

| Release/Version

Avaya

Avaya IP Office 500v2

9.0.3.0 Build 941

Avaya IP Office DIG DCPx16 V2

9.0.3.0 Build 941

Avaya IP Office Manager

9.0.3.0 Build 941

Avaya Voicemail Pro Client

9.0.3.0 Build 212

Avaya 96x0 IP Deskphones (H.323)

Avaya one-X® Deskphone Edition
S3.220A

Avaya 96x1 Series IP Deskphones (H.323)

Avaya one-X® Deskphone H.323
Version 6.4014

Avaya 1120E IP Deskphones (SIP)

SIP1120e Ver. 04.04.14.00

Avaya IP Office Video Softphone 3.2.3.49 68975
Avaya Flare® Experience for Windows 1.1.4.23
Avaya Digital Deskphones 1408 38.0
Avaya Digital Deskphones 9508 0.55
Lucent Analog Phone -
Clearcom
OpenSIPS 1.9
OpenSIPS 1.9

Testing was performed with Avaya IP Office 500 V2, but this testing also applies to Avaya IP
Office Server Edition running the same software release. Note that Avaya IP Office Server
Edition requires an Expansion IP Office 500 V2 R9 to support analog or digital endpoints or

trunks.
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5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the
Avaya IP Office Manager PC, select Start - Programs - IP Office - Manager to launch the
application. A screen that includes the following may be displayed.

WELCOME to IP Office Administration

What would you like to do?

Create an Offline Configuration

| Open Configuration from System|

Read a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the
configuration may be alternatively opened by navigating to File > Open Configuration at the
top of the Avaya IP Office Manager window. Select the proper Avaya IP Office system from the
pop-up window and log in with the appropriate credentials.

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane
on the left side, omit the Group pane in the center, and show the Details pane on the right side.
Since the Group pane has been omitted, its content is shown as submenus in the Navigation pane.
These panes (Navigation, Group and Details) will be referenced throughout the Avaya IP Office
configuration. All licensing and feature configuration that is not directly related to the interface
with the service provider (such as twinning and IP Office Video Softphone support) is assumed
to already be in place.

In the sample configuration, the MAC address 00E00706530F was used as the system name. All
navigation described in the following sections (e.g., License = SIP Trunk Channels) appears
as submenus underneath the system name 00E00706530F in the Navigation Pane.
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5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require Avaya IP Office to
be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in
the Navigation pane. Confirm a valid license with sufficient Instances (trunk channels) in the

Details pane. Note that the full License Keys in the screen below is not shown for security

PUrposes.
IP Offices | X| v
#-R BOOTP (3) [ ticense Remote Server
¢+ Operator (3) e e
=
%9 System (1) Feature License Key Instances Status Expiry Date Source Add... |
#-71 Line 3) Mobility Features OICIuRgHv... 255 Obsolete Never ADI Nodal
Control Unk (4) Advanced Small Community Netw... DaQJ7VeS... 255 Obsolete Never ADI Nodal =
+-4p Extension (38)
o@ User32) IPS00 Voice Networking Channels ~ T39BkqBX.. 255 Valid Never ADI Nodal
-8 Group (1) 1PS00 Upgrade Standard to Profess... QaHgn76v... 255 Obsolete Never ADI Nodal
#-9% Short Code (65) IPS00 Voice Networking Channels  JaHLHAVF... 4 Valid Never ADI Nodal
@ senvice 0) [SIP Trunk Channels 13CQzGBY... 255 Valid Never ADI Nodal
8-dy RAS (1) , VPN IP Extensions @qm3f0o.. 255 Obsolete Never ADI Nodal
Incoming Call Route (2)
WAN Port (0) IP500 Universal PRI (Additional cha... 2TXC@0o... 255 Valid Never ADI Nodal
. Directory (0) RAS LRQ Support (Rapid Response)  hXIRBVCE... 255 Valid Never ADI Nodal
£2) Time Profile (0) IP Office Dealer Support - Standar... 4AOGBVS.. 255 Valid Never ADI Nodal
#-@ Firewall Profile (1) IP Office Dealer Support - Professi... dlyY_DbaS... 255 Valid Never ADI Nodal
: :fctx:t(ts::dew) IP Office Distributor Support - Stan... dvOS6B9iX... 255 Valid Never ADI Nodal
IP Office Distributor Support - Prof... LIMFZqB6... 255 Valid Never ADI Nodal
W Tunnel (0) UMS Web Services pGcSuPdL... 255 Valid Never ADI Nodal
-85 User Rights (8) Customer Service Agent JOhEoAA... 255 Valid Never ADI Nodal
#-'¢ ARS (1) 1600 Series Phones UaKn2Pm... 255 Valid Never ADI Nodal
# RAS Location Request (0) Third Party API fan7@T6R... 255 Valid Never ADI Nodal
8, Location 0) Software Upgrade 255 ohIWFvM... 1 Valid Never ADI Nodal
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To view the physical hardware comprising Avaya IP Office, expand the components under the
Control Unit in the Navigation pane. In the sample configuration, the Avaya IP Office 500v2 is
equipped with analog and digital extension expansion modules, as well as a VCM64 (Voice
Compression Module) for supporting VolP codecs. An Avaya IP Office hardware configuration

with a VCM component is necessary to support SIP trunking.

To view the details of the component, select the component in the Navigation pane. The
following screen shows the details of the IP 500 V2.

IP Offices

IP 500 V2

+

+

+

+

+

+

+

+

+

+

+

+]-4

=) Ry

#-& BOOTP (3)

Operator (3)
00E00706530F
%2 System (1)
T4 Line 3)
“2 Control Unit (4)
-
“= 2VCM64/PRID U
= 3 PHONES
“= 6 DIG DCPx16 V2
4 Extension (38)
i User (32)
a Group (1)
#X% Short Code (65)
D Service (0)
o RAS (1)

- Incoming Call Route (2)

€2 WAN Port (0)

@= Directory (0)

£ Time Profile (0)
@ Firewall Profile (1)
KB 1P Route (5)

#m Account Code (0)
W License (74)

W& Tunnel (0)

§3 UserRights (8)
‘€ ARS (1)

#~ RAS Location Request (0)

& Location (0)

Unit

Device Number

Unit Type

Version

Serial Number

Unit IP Address
Interconnect Number

Module Number

1

IP 500 V2

9.0.300.941

“

172.16.5.60

0

Control Unit
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5.2. System

Configure the necessary system settings. In an Avaya IP Office the LAN2 tab settings
correspond to the Avaya IP Office WAN port (public network side) and the LAN1 tab settings
correspond to the LAN port (private network side).

5.2.1. System — LAN2 Tab

In the sample configuration, the Avaya IP Office WAN port was used to connect to Clearcom.
The LAN2 settings correspond to the WAN port on the Avaya IP Office 500 V2. To access the
LANZ2 settings, first navigate to System - <Name>, where <Name> is the system name
assigned to the Avaya IP Office. In the case of the compliance test, the system name is the MAC
address 0OE00706530F. Next, navigate to the LAN2 - LAN Settings tab in the Details Pane.
Set the IP Address field to the public IP address assigned to the Avaya IP Office WAN port. Set
the IP Mask field to the mask used with the public IP address. All other parameters should be
set to default or according to customer requirements. Click Ok to commit (not shown).

IP Offices = 00E00706530F

i K gOOTlP (3()3) System | LANL DNS ‘ Voicemail ‘ Telephony | Directory Services | System Events ‘ SMTP ‘ SMDR ‘ Twinning ‘ VCM ‘ CCR ‘ Codecs | ACCS
-4/ Operator

=|*=» 00E00706530F LAN Settings | volP |NetwnrkTopoIogy

+-%% System (1)
+-T4 Line (3) IP Address 192 . 168 . 157 . 187
#-<“w Control Unit (4)
-4 Extension (38) P Mask 255 . 255 . 255 . 192

+ t User (32)

A sﬂ Group (1)

+-@% Short Code (65)
@ Service (0)

- RAS (1) RIP Mode |None ~|

4 e Incoming Call Route (2) ) g
€ WAN Port (0) Enable NAT
@& Directory (0)
‘ Time Profile (0) Number Of DHCP IP Addresses 1

#-@ Firewall Profile (1) DHCP Mode

+-Jill IP Route (5)
a1 Account Code (0) Server Client Dialin @ Disabled T
% License (74)
@& Tunnel (0)

+ ﬁ‘, User Rights (8)

41 ARS (1)

-~ RAS Location Request (0)
5 Location (0)

Primary Trans. IP Address 0 0 0 0

Firewall Profile ‘(Nun:) v‘
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On the VoIP tab in the Details Pane, configure the following parameters:
e Check the SIP Trunks Enable box to enable the configuration of SIP trunks.
e The RTP Port Number Range can be customized to a specific range of receive ports for
RTP media. Based on this setting, Avaya IP Office would request RTP media be sent to
a UDP port in the configurable range for calls using LAN2.

IP Offices J 1= 00E00706530F v | <
A BOOOT:’ ‘3()” System | LANI | LAN2 |DNS | Veicemil | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning [ VCM | CCR | Codecs | ACcS
47 Operator |
“ 00EO0T06530F LAN Settings Network Topology
s stem
“ 00ED0706530F H323 Gatekeeper Enable
#-11 Line G) to-create Extn Auto-create User H323 Remote Extn Enable

<= Control Unit (4)
+-4p Extension (38)
#-§ User32)
#-9% Short Code (65)

@ Service 0) SIP Registrar Enable
t-dly RAS (1) Auto-create Ext/User SIP Remote Extn Enable
#-§) Incoming Call Route (2)

& WAN Port (0)

= Directory (0)

£ Time Profile (0) uDP
#-@ Firewall Profile (1)
#-fll IP Route (5) TP
#m Account Code (0) <
. License (74) s
W Tunnel 0)
+-§5 User Rights (8)
@-“¢ ARS (1)
#~ RAS Location Request (0) RTP
8 Location () Port Number Range
Minimum 49152 L Maximum 53246
Port Number Range (NAT)
Minimum 49152 e Maximum 53246
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Scroll down the page.

In the RTP Keepalives section, set the Scope to RTP. Set the periodic timeout to 30 and
the Initial Keepalives parameter to Enabled. These settings will cause Avaya IP Office
to send a RTP keepalive packet starting at the time of initial connection and every 30

seconds thereafter if no other RTP traffic is present. This facilitates the flow of media in
cases where each end of the connection is waiting to see media from the other, as well as

helping to keep firewall ports open for the duration of the call.
e Inthe DiffServ Settings section, Avaya IP Office can also be configured to mark the
Differentiated Services Code Point (DSCP) in the IP Header with specific values to
support Quality of Services policies for both signaling and media. The DSCP field is the
value used for media and the SIG DSCP is the value used for signaling. The specific
values used for the compliance test are shown in the example below and are also the
default values. For a customer installation, if the default values are not sufficient,
appropriate values will be provided by the customer.
e All other parameters should be set to default or according to customer requirements.
e Click Ok to commit (not shown).

=1-“% 00E00706530F

-9 System (1)
“% 00E00706530F
#H-14 Line (3)
#-<=» Control Unit (4)
+-4 Extension (38)
#-§ User(32)
£ :ﬂ Group (1)
#-9% Short Code (65)
B Service (0)
ol RAS (1)
£ @ Incoming Call Route (2)
-§@ WAN Port (0)
@& Directory (0)
£ Time Profile (0)
=@ Firewall Profile (1)
=-Jill IP Route (5)
- Account Code (0)
W License (74)
W% Tunnel (0)
& &‘, User Rights (8)
#-“¢ ARS (1)
# RAS Location Request (0)
B Location (0)

LAN Settings | VoIP Network Topology

IP Offices | = 00E00706530F
=R BOOTP B3) System | LANL DNS ‘ Voicemail ‘ Telephony | Directory Services | System Events ‘ SMTP ‘ SMDR ‘ Twinning | VCM ‘ CCR ‘ Codecs | ACCS
1% Operator (3)

V| Enable RTCP Monitoring on Port 5005

Keepalives

Scope {RTP v ‘ Periodic timeout

Initial keepalives Enabled -

DiffServ Settings

B8 < | DSCP(Hex) B8 -+ Video DSCP(Hex) FC ~| DSCP Mask (Hex) 88

46 = DSCP 46 > Video DSCP 63 +| DSCP Mask 34

DHCP Settings

Primary Site Specific Option Number (SSON) 176
Secondary Site Specific Option Number (SSON) 242
VLAN |Nul Present -

1100 Voice VLAN Site Specific Option Number (SSON) 232

1100 Voice VLAN IDs

< | SIG DSCP (Hex)

< SIG DSCP
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On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. Since no firewall or network address translation (NAT) device was used
between the Avaya IP Office and the Clearcom, the parameter was set to Open Internet.

e Set the Binding Refresh Time (seconds) to a desired value, the value of 300 (or every 5
minutes) was used during the compliance testing. This value is used to determine the
frequency that IP Office will send OPTIONS heartbeat to the service provider.

e Set Public IP Address to the IP address of the Avaya IP Office WAN port.

e Inthe Public Port section, next to the transport protocol UDP, select the UDP port on
which Avaya IP Office will listen.

e All other parameters should be set to default or according to customer requirements.

e Click Ok to commit (not shown).

£ e Incoming Call Route (2)
2 WAN Port (0)
@& Directory (0)
~£1) Time Profile (0)
@ Firewall Profile (1)
+-Jilll IP Route (5)
| Account Code (0)
W License (74)
@& Tunnel (0)
#-fg User Rights (8)
H- g ARS (1)
@ RAS Location Request (0)
8 Location (0)

&

Public Port

uDP 5060

TCP 0

TLS 0

Run STUN on startup

IP Offices | = 00E00706530F

2-K BoOTP 3 System ‘ LAN1 DNS ‘ Voicemail ‘ Telephony | Directory Services | System Events ‘ SMTP | SMDR ‘ Twinning ‘ vcM | CCR ‘ Codecs | ACCS
+1-¢% Operator (3)
= 0E00706530F LAN Settings | VolP

#-T1 Line (3) STUN Server Address 69.90.168.13 STUN Port 3478

#-<= Control Unit (4)

+-4 Extension (38) Firewall/NAT Type Open Internet -

#-§ User(32)

38 Group (1) Binding Refresh Time (seconds) 300

=-@% Short Code (65) —_—

@ Service (0) Public IP Address 192 . 168 . 157 . 187 Run STUN Cancel
-olls RAS (1)

Note: In the compliance test, the LANL1 interface was used to connect the Avaya IP Office to the
enterprise site IP network (private network). The LANL1 interface configuration is not directly
relevant to the interface with the Clearcom SIP Trunk Service, and therefore is not described in
these Application Notes.
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5.2.2. System - Telephony Tab

To access the System Telephony settings, navigate to the Telephony - Telephony tab in the
Details Pane. Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding
and call transfer to the PSTN. If for security reasons incoming calls should not be allowed to
transfer back to the PSTN then leave this setting checked. All other parameters should be set to
default or according to customer requirements. Click OK to commit (not shown).

IP Offices

00E00706530F

- R BOOTP (3)
#4# Operator (3)
% 00E00706530F

00E00706530F
-4 Line (3)
#-“=» Contrel Unit (4)
+-4p Extension (38)
§ User(32)
+-498 Group (1)
+-@% Short Code (65)
@ Service (0)
+-ols RAS (1)
+ @ Incoming Call Route (2)
& WAN Port (0)
#m Directory (0)
£ Time Profile (0)
+-@ Firewall Profile (1)
+- il IP Route (5)
& Account Code (0)
W License (74)
@& Tunnel (0)
1§53 User Rights (8)
#- ¢ ARS (1)
# RAS Location Request (0)
5 Location (0)

elephony | Park & Fag:| Tones & Muslcl Ring Tones ‘ SM

Analogue Extensions

System | LAN1 ‘ LAN2 | DNS ‘ Voicemail Directory Services | System Events ‘ SMTP ‘ SMDR | Twinning ‘ VCM ‘ CCR | Codecs | ACCS

Companding Law

Default Outside Call Sequence [Normal
Default Inside Call Sequence ‘ Ring Typel
Default Ring Back Sequence ‘ Ring Type 2
Restrict Analogue Extension Ringer Voltage

Dial Delay Time (secs) 3

Dial Delay Count 0

Default No Answer Time (secs) 15

Hold Timeout (secs) 0

Park Timeout (secs) 300

Ring Delay (secs) 5

Call Priority Promotion Time (secs) |Disabled

Default Currency [usp -
Default Name Priority | Favor Trunk -]
Media Connection Preservation | Disabled -

<

@ U-Law

Switch Line

@ U-Law Line

A-Law A-Law Line

DSS Status
Auto Hold
Dial By Name

Show Account Code

Inhibit Off-Switch Forward/Transfer

<

Restrict Network Interconnect

Drop External Only Impromptu Conference
Visually Differentiate External Call

Unsupervised Analog Trunk Disconnect Handling
High Quality Conferencing

Strict SIPS

5.2.3. System - Twinning Tab

To view or change the System Twinning settings, navigate to the Twinning tab in the Details
Pane as shown in the following screen. The Send original calling party information for
Mobile Twinning box is not checked in the sample configuration, and the Calling party
information for Mobile Twinning is left blank. Click OK to commit (not shown).

IP Offices

00E00706530F

#-R BOOTP (3)
+-i# Operator (3)
=% 00E00706530F
={*% System (1)
.= 0DE00706530F
@19 Line (3)
#-<=» Control Unit (4)
# -4 Extension (38)
w-f§ User(32)
-5 Group (1)
59X Short Code (65)
B Service (0)
o4 RAS (1)
Q Incoming Call Route (2)
€9 WAN Port (0)
@ Directory (0)
£ Time Profile (0)
@ Firewall Profile (1)
@ 1P Route (5)
#m Account Code (0)
W License (74)
@& Tunnel (0)
$3 UserRights (8)
&~ ARS (1)
#~ RAS Location Request (0)
& Location (0)

Sys(em] LANL l LAN2 [ DNS ] Voicemail | Telephony | Directory Services | System Events [ SMTP l SMDR VCM l CCR [ Codecs | ACCS

Send original calling party information for Mobile Twinning

Calling party information for
Mobile Twinning
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5.3. IP Route

Create an IP route to specify the IP address of the gateway or router where the IP Office needs to
send the packets in order to route calls to Clearcom’s network.

Navigate to IP Route - 0.0.0.0 in the left Navigation Pane if a default route already exists,
otherwise, to create the default route, right-click on IP Route and select New. Create/verify a
default route with the following parameters:

e Set IP Address and IP Mask to 0.0.0.0.

e Set Gateway IP Address to the IP address of the default router for the public network

where Avaya IP Office is connected.
e Set Destination to LAN2 from the drop-down list.
e Click the OK to commit (not shown).

IP Offices | EZ 0.0.0.0°

- R BOOTP (3) IP Route
+-4# Operator (3)
=-%% 00E00706530F IP Address
%2 System (1)

r
+
+-
+
+

4 Line 3)
Control Unit (4)
& Extension (38)
i User (32)

+-5af Group (1)
+-8% Short Code (65)

@ Service (0)

IP Mask 0 0 0 0

Gateway IP Address

Destination

192 168 157

129

LAN2

Metric 0
[”] Proxy ARP

+-oflg RAS (1)

* e Incoming Call Route (2)
€ WAN Port (0)
@ Directory (0)
£ Time Profile (0)

+ Firewall Profile (1)
={lill IP Route (5)
1 1]0.000
10.10.10.0

il 17216.50
192.168.10.0
192.168.99.0
@m Account Code (0)
e License (74)
W& Tunnel (0)
+-§3 User Rights (8)
+-"¢ ARS (1)
#~ RAS Location Request (0)
& Location (0)
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5.4. SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and Clearcom SIP
Trunk Services. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP
Office Manager to create a SIP Line. Follow the steps in Section 5.4.1 to create the SIP Line
from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses.

e SIP Trunk Registration Credentials.

e SIP URI entries.

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Sections 5.4.2 — 5.4.5.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.

To create a SIP Line manually, right-click Line in the Navigation Pane and select New - SIP
Line; then, follow the steps outlined in Sections 5.4.2 - 5.4.5.
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5.4.1. SIP Line From Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to MX_Clearcom_SIPTrunk.xml. The file name is important in locating

the proper template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File > Preferences. In the IP Office Manager Preferences window that
appears, select the Visual Preferences tab. Verify that the box is checked next to Enable
Template Options. Click OK.

3.

%" IP Office Manager Preferences

— e

Preferences l Directories | Discovery | Visual Preferences | Security I Validation |

Icon Size I Small

-

Multiline Tabs

| ¥ EnableTempIateOptions|

{ oK \ Cancel H Help l

Import the template into IP Office Manager. From IP Office Manager, select Tools >

Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down
menus in Step 5. The default template location is C:\Program Files\Avaya\IP
Office\Manager\Templates.

B¢ ARS (1)
- RAS Location
i Location (0)

& Q‘, User Rights (8)

Manager PCIP Address
Request (0) Avaya HTTP Clients Only

Enable Softphone HTTP Provisioning

File Edit View [ Tools | Help
IP Office Extension Renumber... 00E00706530F
" Line Renumber...
¥ gOOTf (3()3) Connect To... DNS J Voicemail l Telephony l Directory Services | System Events l SMTP I SMDR l Twinning J VCM I CCR l Codecs | ACCS
+)-¢# Operator L
SRR Export » 00E00706530F Locale |United States (US English) v
-5 System (1) =
917 Line G3) SCN Service User Management Location [<Nune> v}
#-“= Control Unit Busy on Held Validation
+-4 Extension (3
©-§ User(32) MSN Cenfiguration place System under special control
-3 Group (1) Print Button Labels
#-9% Short Code =
@ Senvice 0) Import Templates in Manager
ol RAS (1)
& e Incoming Call Route (2)
€ WAN Port (0)
o Directory (0) DevicelD
£ Time Profile (0)
e @ Firewall Profile (1) TFTP Server IP Address 255 255 255 255
@ IP Route (5
E Ach:net E:Z’di © HTTP Server IP Address 0 0 0 0
W License (74) .
@ Tunnel (0) Phone File Server Type Memory Card - HTTP Redirection ‘u

255 255 255 255

Favor RIP Routes, over static routes
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In the pop-up window that appears (not shown), select the directory where the template
file was copied in Step 1. After the import is complete, a final import status pop-up
window (not shown) will appear stating success or failure, click OK (not shown) to
continue. If preferred, this step may be skipped if the template file is copied directly to
the IP Office template directory.

4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane,
then navigate to New - New SIP Trunk From Template.

IP Offices |E SIP Line - Line 17
=R BOOTP @) SIP Line Transport SIP URI|VolP [ T38 Fax|SIP Credentials
+-47 Operator (3)
=539 00E007(F=2= =
i syst| L] New v H323 Line
: i c ] Generate SIP Trunk Template 1P DECT Line In Service i
- on
: P Li
H-4 Bde ¥ Cut Ctrl+X AL URIType iSIP vl
* a User c Ctrls SM Line
-8 Gro{ = COPY i SIP DECT Line Check 00S v
+-§% Sho Paste Ctrl+V
@ Senv 7 Delete Ctrl+Del New SIP Trunk From Template Call Routing Method [Tn Header v]
& RAS Valid. Originator number for
v alidate
e Ineg _ ~ forwarded and twinning calls avayasbcl
@ wal Connect To... Ctrl+T
:‘ ?"E New from Template (Binary) Name Priority [System Default v}
£ Tim)
@ Fire Export as Template (Binary) lNone - ‘ Caller ID from From header
il 1P Route [5) I
-am Account Code (0) Association Method [By Source IP address v] Send From In Clear
," License (74) User-Agent and Server
W& Tunnel (0) Headers
§3 UserRights (8)
“¥ ARS (1) Service Busy Response [4186 - Busy Here v]
~a RAS Location Request (0) . . o
B8 Location (0) Action on CAC Location Limit ‘Allow T = ‘

5. In the subsequent Template Type Selection pop-up window, select Mexico from the
Country pull-down menu and select Clearcom from the Service Provider pull-down
menu as shown below. These values correspond to parts of the file name
(MX_Clearcom_SIPTrunk.xml) created in Step 1. Click Create new SIP Trunk to
finish creating the trunk.

T -
.
" Template Type Selection L —
-
Locale United States (US English 5
Country [Mexico v] |
Service Provider [Clean::om v} | Display Al
l Create new SIP Trunk l I Cancel
e — — Y

6. Once the SIP Line is created, verify the configuration of the SIP Line with the
configuration shown in Sections 5.4.2 — 5.4.5.

HG; Reviewed: Solution & Interoperability Test Lab Application Notes 20 of 39
SPOC 10/15/2014 ©2014 Avaya Inc. All Rights Reserved. ClearcomIPO9



5.4.2. SIP Line = SIP Line Tab

On the SIP Line tab in the Details Pane, configure or verify the parameters as shown below.

e Set ITSP Domain Name to clearcom.mx, the domain name for Clearcom.

e Verify that Send Caller ID is set to None, the default value.

e For the compliance testing REFER Support was disabled. Thus, REFER Support
should be unchecked. Refer to Section 2.2.

e Verify that In Service box is checked, the default value. This makes the trunk available
to incoming and outgoing calls.

e Verify that Check OOS box is checked, the default value. Avaya IP Office will use the
SIP OPTIONS method to periodically check the SIP Line. The time between SIP
OPTIONS sent by Avaya IP Office will use the Binding Refresh Time for LAN2, as
shown in Section 5.2.1.

e Set the Call Routing Method to To Header.

e Set the Originator number for forwarded and twinning calls to User123. This is the
authentication name or User Name credentials used for SIP Trunk registration purposes.
This setting was required for forwarded and twinned calls to be accepted by Clearcom.
SIP Trunk registration credentials information should be provided by Clearcom.

e All other parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

IP Offices | Ex SIP Line - Line 17*
- R BOOTP (3) Transpon|SIP URI|VolP [ T38 Fax|SIP Credentials
545 Operator () , -
=J-%% 00E00706530F Line Number d 2
$ m” [ITSP Domain Name clearcommx_ | In Service v |
| =1 URI Type (s -
*: ,| Unit (4) Prefix Check 00S vl
¢ : ﬁ::(szizu)n Gn National Prefix Call Routing Method [ To Header -
o oy Country Code forearded i g cals U2
+: g :Z?(EIE) 0 International Prefix Name Priority | System Default -

@ Incoming Call Route (2)
£ WAN Port (0)

—--R

Send Caller ID lNone | - ‘ Caller ID from From header

H ':“ Directory @) Association Method ‘By Source IP address - ‘ Send From In Clear ]
£ ") Time Profile (0)
0 @ Firewall Profile (1) User-Agent and Server
#-Jill IP Route () Headers
-8 Account Code (0) .
"W License (74) Service Busy Response ‘436 - Busy Here - ‘
- Tunnel (0) Action on CAC Location Limit ‘Allow Voicemail - ‘
#-f3 User Rights (8) ¢ J
- RAS Location Request (0)
“-i@ Location (0) Always
Method for Session Refresh Auto v
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5.4.3. SIP Line - Transport Tab
Select the Transport tab. Set or verify the parameters as shown below.

e Leave the ITSP Proxy Address blank (IP Office will retrieve the ITSP Proxy Address

using public DNS queries).
e Set Layer 4 Protocol to UDP.

e Set Use Network Topology Info to LANZ2, the network port used by the SIP line to

access the far-end and configured in Section 5.2.1.
e Set the Send Port to 5060.

e Set Explicit DNS Server(s) to the IP addresses of the primary and secondary public DNS
Servers used by the enterprise. This information should be provided by the local ISP. IP

Office will use public DNS queries using Clearcom’s domain name provided

(clearcom.mx) to obtain the public IP of Clearcom.
e Default values may be used for all other parameters.
e Click Ok to commit (not shown).

‘-'_f'__ Avaya IP Office Manager 00E00706530F [9.0.300.941] [Administrator(Administrator)]

File Edit View Tools Help

IP Offices |2

SIP Line - Line 17°

#-R BOOTP (3)

SIP Line| Transport [SIp URI| VolP | T38 Fax|SIP Credentials
+-¢# Operator (3) [

=1-%%y 00E00706530F |ITSP Proxy Address |
-9 System (1)
= —T‘, Line (3) - :
; -1 Network Cenfiguration

o 2 Layer 4 Protocol [UDP '] Send Port 5060

[ 17
+)-“= Control Unit (4) Use Network Topology Info ‘ LAN 2 v ‘ 5060
+-4 Extension (37)
£ @ User(G2) Bxplicit DNS Server(s) 0 .05 .26 .12 |10 . 5 . 153 . 42 |
+ ﬂ Group (1)
+-@% Short Code (65)
@ Service (0)
ol RAS (1)
4 e Incoming Call Route (2)
€ WAN Port (0)
@ Directory (0)
£ Time Profile (0)
@ Firewall Profile (1)
+- [l IP Route (6)
#m Account Code (0)
- License (74)
W Tunnel (0)
+-§3 User Rights (8)
+-"¢ ARS (1)
-« RAS Location Request (0)
‘i@ Location (0)

Calls Route via Registrar |V

Separate Registrar
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5.4.4. SIP Line - SIP URI Tab

Two SIP URI entries must be created to match each outgoing number that Avaya IP Office will
send on this line and incoming numbers that Avaya IP Office will accept on this line.

To set the SIP URI for outgoing numbers, select the SIP URI tab, then click the Add button and
the New Channel area will appear at the bottom of the pane. To edit an existing entry, click an
entry in the list at the top, and click the Edit button. The entry was created with the parameters
shown below:
e Set Local URI, Contact, Display Name and PAI to Use Credentials User Name.
e Set Registration to 1: User123 (Note that this field will default to the User Name used
under the SIP Credentials tab).
e Set Incoming Group to 0.
e Set Outgoing Group to 17 (SIP Line number being used).
e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.
e Click OK to commit.

IP Offices |2 SIP Line - Line 17°
- R BOOTP (3) SIP Line| Transport|SIP URI |VolP | T38 Fax| SIP Credentials
#-¢# Operator (3) -
=-%3y D0E00706530F Channel Groups Via Local URI Contact Display Name PAI Credential Add...
7% System (1) 1 17 0 192.168.157.187 None  0:<Non.. |
2 2 0 17 192168157187 Userl23  Userl23 Userl23 Userl23 1: Userl23 femove
'— 2 Edit...
e

+-<=» Control Unit (4)
+-4fp BExdension (37)

w-§  User(32)
4§ Group (1)
9% Short Code (65)
- Service (0)
o RAS (1)
-9 Incoming Call Route (2)
&) WAN Port (0) Edit Channel
@8 Directory (0) [ QK ]
£ Time Profile (0) Via 192.168.157.187
1 % IF;;::LT;;ME @ Local URI Use Credentials User Name - ‘ Cancel
: ficcce?ﬂlsjst(ﬁgde 0 Contact Use Credentials User Name -
- Tunnel (0) Display Name Use Credentials User Name v
4§13 UserRights (8)
#-"¢ ARS (1) PAI Use Credentials User Name v
- RAS Location Request (0)
&8 Location (0) Registration 1: Userl23 -
Incoming Group 0
Outgoing Group 17
Max Calls per Channel 10 -
HG; Reviewed: Solution & Interoperability Test Lab Application Notes 23 of 39

SPOC 10/15/2014 ©2014 Avaya Inc. All Rights Reserved. ClearcomIPO9



To set the SIP URI for incoming numbers, select the SIP URI tab, then click the Add button and
the New Channel area will appear at the bottom of the pane. To edit an existing entry, click an
entry in the list at the top, and click the Edit button. The entry was created with the parameters

shown below:

e Set Local URI, Contact, and Display Name to Use Internal Data.
e Set PAI to None.

e Set Registration to 0: <None>.

e Set Incoming Group to 17 (SIP Line number being used).

Set Outgoing Group to 0.

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.
e Click OK to commit.

IP Offices

f--ﬂ BOOTP (3)
#-¢# Operator (3)
=% 00E00706530F
-] System (1)
%% 00EQ0706530F
= [1‘ 1 Line (3)
2
t-<“2 Control Unit (4)
t-4 Extension (37)
t-§  User (32)
H ﬂ Group (1)
8% Short Code (65)
B Service (0)
t-allg RAS (1)
t e Incoming Call Route (2)
¥ WAN Port (0)
@& Directory (0)
£ Time Profile (0)
H-@ Firewall Profile (1)
+-[ill IP Route (6)
-l Account Code (0)
% License (74)
- Tunnel (0)
t-f5 UserRights (8)
H-“¢ ARS (1)
" RAS Location Request (0)
i@ Location (0)

7 SIP Line - Line 17*

sIp Line[Transportlm'VolP | 738 Fax|sIP Credential

‘ Channel Groups Via Local URI Contact Display Name PAI Credential Add...
1 0 17 192168.157.187 Userl23  Userl23 Userl23 Userl23 1: Userl23
2 17 0 102.168.157.187 None 0: <Non... femave

Edit...

Edit Channel
Via 192.168.157.187 [ ok ]
Local URI Use Internal Data - Cancel
Contact Use Internal Data -
Display Name Use Internal Data -
PAI None] -
Registration [0: <None> A
Incoming Group 17
Qutgoing Group 0
Max Calls per Channel 10 -

Additional SIP URIs may be required to allow inbound calls to numbers not associated with a
user, such as a short code. These URIs are created in the same manner as shown above with the
exception that the incoming DID number is entered directly in the Local URI, Contact, and

Display Name fields.
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5.45. SIP Line - VoIP Tab

Select the VoI P tab, to set the Voice over Internet Protocol parameters of the SIP line. Set or
verify the parameters as shown below.

e For Codec Selection, select System Default from the pull-down menu to use the default
list of codecs. A list of the codecs in their current order of preference will be shown on
the right in the Selected column. To use a custom list of codecs, select Custom for
Codec Selection. Next, move unwanted codecs from the Selected column to the Unused
column. Lastly, move the codecs up or down the list in the Selected column to achieve
the desired order of preference. The example below shows the codecs used for the
compliance test (Note that Custom Codec Selection was used). The list must include
G.729(a), G.711ALAW and G.711 ULAW which are the codecs supported by Clearcom.
Codecs are listed in preferred codec order (from top to bottom).

e Uncheck the VoIP Silence Suppression box.

Uncheck Allow Direct Media Path and Force direct media with phones box. This
setting was not tested.

Check the Re-invite Supported box.

Check the PRACK/100rel Supported box.

Set the Fax Transport Support to T.38. Refer to Section 2.2.

Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

Default values may be used for all other parameters.

e Click the OK to commit (not shown).

IP Offices |E SIP Line - Line 17

e

R B0OTP (3) SIP Line| Transport siP URI|VolP |38 Fax|SIP Credentials
¥ Operator (3) B
% 00E00706530F VolIP Silence Suppression

+-%% System (1)
271 Line B3) Allow Direct Media Path

1 Codec Selection Custom "
2
Srioed petecte Codec Lockdown
+-“= Control Unit (4) G.722 64K >5> G.729(a) 8K CS-ACELP
+-4 Extension (37) G.723.1 6K3 MP-MLQ G.711 ALAW 64K I ¥| PRACK/100rel Supported
#-§ User(32) G.711 ULAW 64K
-5 Group (1) Force direct media with phones
+-9% Short Code (65) - -
@ senvice ) G.711 Fax ECAN
ol RAS (1)
+ Q Incoming Call Route (2)
& WAN Port (0)
@= Directory (0)
£ Time Profile (0)
©-@ Firewall Profile (1)
+ IP Route (6)
&m Account Code (0)
W License (74)
W& Tunnel (0)
+ ﬂ; User Rights (8)
- ARS (1)
@~ RAS Location Request (0) |DTMF Support |RFC2833 v‘|
@& Location (0)

1)@

¥| Re-invite Supported

Fax Transport Support iTBS V‘|

Location ‘ Cloud |

Call Initiation Timeout (s) 4
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5.4.6. SIP Line —T38 Fax Tab

Select the T38 Fax tab, to set the T.38 Fax parameters of the SIP line. Set or verify the
parameters as shown below.

e For T38 Fax Version, select 0 from the pull-down menu.
e Check Disable T30 ECM.
e Default values may be used for all other parameters.
e Click the OK to commit (not shown).
IP Offices = SIP Line - Line 17
#-R BOOTP (3) 'SIP Line| Transport |SIP URI|VolP | T38 Fx [SIP Credentials
*-i7 Operator (3)
=12 00E00706530F |T38 Fax Version [0 '] |
- System (1) ¥| Scan Line Fix-up
E--_H Line (3) Transport UDPTL _
—— +/| TFOP Enhancement
— Redundancy ___
e /] Disable T30 ECM
Low Speed 0 L :
#-=» Control Unit (4) | Disable EFlags For First DIS
;f; Ef:,"g;)n 7 High Speed ’ [7] Disable T30 MR Compression
+-3 Group (1) TCF Method (Trans TCF - NSF Override
=-9% Short Code (65) .
-8 Service (0) Max Bit Rate (bps) l14400 '] L
-l RAS (1) _ ;
=3 Incoming Call Route (2) EFlag Start Timer (msecs) 2600 i
- WAN Port (0) ,
& Directory (0) EFlag Stop Timer (msecs) 2300
£ Time Profile (0) )
%@ Firewall Profile (1) Tx Network Timeout (secs) 150
+-fill IP Route (6)
-l Account Code (0)
- R, License (74)
@ Tunnel (0)
#-§3 User Rights (8)
= ARS (1)
" RAS Location Request (0)
- Location (0)
] Use Default Values
HG; Reviewed: Solution & Interoperability Test Lab Application Notes 26 of 39

SPOC 10/15/2014

©2014 Avaya Inc. All Rights Reserved.

ClearcomIPO9




5.4.7. SIP Line — SIP Credentials Tab

Select the SIP Credentials tab, and then click the Add button to add the SIP Trunk registration
credentials. Set the parameters as show below.

e For User name, add the user name credential provided by Clearcom for SIP Trunk
registration.

e For Authentication Name, add the authentication name credential provided by Clearcom
for SIP Trunk registration, this should be the same as the User name above.

e For Password, add the password credential provided by Clearcom for SIP Trunk
registration.

e Set Expiry (mins) to a value acceptable to the enterprise. This setting defines how often
registration with Clearcom is required following any previous registration. For the
compliance test 2 minutes was used.

e Verify that Registration required is checked.

e Click the OK to commit.

IP Offices |E; SIP Line - Line 17°
g K gigr:fo%’ [SIP Line | Transport siP URI|VolP [ T38 Fax SIP Credentials
=1+ 00E00706530F Index UserName Authentication Name Contact Expiry (mins) Register Add...
!
Edit...

7

<= Control Unit (4)
-4 Extension (37)
w-§ User(32)

=i Group (1)

#-8% Short Code (65)
B Service (0)

o RAS (1)

£ @ Incoming Call Route (2)
€ WAN Port (0)

@x Directory (0)

£ Time Profile (0)
w-@ Firewall Profile (1)
=-Jill 1P Route (6)

| Account Code (0) Edit SIP Credentials -
% License (74) User name m ‘ 0K
W% Tunnel (0)
w-§3 User Rights (8) Authentication Name Userl23 Cancel
B¢ ARS (1) I
" RAS Location Request (0) Contact
i Location (0)
Password sssssssssess
Expiry (mins) 2
Registration required [+
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5.5. Outbound Call Routing

For outbound call routing, a combination of system short codes and Automatic Route Selection
(ARS) entries are used. With ARS, features like time-based routing criteria and alternate routing
can be specified so that a call can re-route automatically if the primary route or outgoing line
group is not available. While detailed coverage of ARS is beyond the scope of these Application
Notes, and alternate routing was not used in the reference configuration, this section includes
some basic screen illustrations of the ARS settings used during the compliance testing.

5.5.1. Short Codes and Automatic Route Selection

To create a short code to be used for ARS, right-click on Short Code on the Navigation Pane
and select New. The screen below shows the short code 9N created (note that the semi-colon is
not used here). In this case, when the Avaya IP Office user dials 9 plus any number N, instead of
being directed to a specific Line Group ID, the call is directed to Line Group 50: Main, which
is configurable via ARS.
e Inthe Code field, enter the dial string which will trigger this short code. In this case, 9N
was used (note that the semi-colon is not used here).
e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.
e Setthe Line Group Id to 50: Main to be directed to Line Group 50: Main, this is
configurable via ARS.
e Click the OK to commit (not shown).

N—

IP Offices |E 9N: Dial
#-® BOOTP (3) || Short Code
#-¢% Operator (3)
=13 00E00706530F Code 9N
+)-%39 System (1)
44 Line (3) Feature Dial -
#-“= Control Unit (4)
-4 Extension (37) Telephone Number N
@ User (32) E . Tren .
8% Groun Line Group ID 50: Mai
=[9% Short Code (65) Locale -
X% 00
X% 01 Force Account Code
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The following screen shows the example ARS configuration for the route Main. Note the
sequence of X’s used in the Code column of the entries to specify the exact number of digits to
be expected, following the access code and the first set of digits on the string. This type of setting
results in a much quicker response in the delivery of the call by IP Office.

To create a short code to be used for ARS, select ARS - 50: Main on the Navigation Pane and
click Add.
e Inthe Code field, enter the dial string which will trigger this short code. In this case, 001
followed by 10 X’s to represent the exact number of digits.
e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to 001N. The value N represents the additional number of digits
dialed by the user after dialing 001 (The 9 will be stripped off).
e Setthe Line Group Id to the Line Group number being used for the SIP Line, in this
case Line Group ID 17 was used.
e Click OK to commit.

New Short Code E
Code D01 XOCCOOOOOK l 0K ‘
Feature | Dial -
| Cancel ‘
Telephone Number DO1N —
| Line Group ID 17} -
Locale | =
i Force Account Code

Repeat the above procedure for additional dial patterns to be used by the enterprise to dial out
from IP Office.
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The first example highlighted below shows that for calls from Mexico to the North American
numbering plan, the user dialed 9, followed by 001 and 10 digits (represented by 10 X’s). The
second example highlighted shows an eight digit number starting with a 28, which is for local
calls in Mexico, the user dialed 9, followed by the local number (e.g., 28811234). In each case

the 9 is stripped off, the remaining digits, including the 001 and 28 shown in the examples

below, are included in the SIP INVITE message IP Office sends to Clearcom.

IP Offices

#- R BOOTP (3)
+-i7 Operator (3)
% 00E00706530F
-y System (1)
#-9 Line 3)
#-<=» Control Unit (4)
+- 4 Extension (37)

ARS

ARS Route Id

Route Name

Main

Z| Secondary Dial tone

SystemTone -

+-@ User (32) Dial Delay Time System Default (3) ¥| Check User Call Barring
+-iaf Group (1)
+)-9% Short Code (65)

@ service (0)
L% RAS () In Service 7 Out of Service Route | <None> -
+ Q Inceming Call Route (2) I

& WAN Port (0)

@u Direct. 0

G T::; ;:;EI: © Time Profile None> — O Ut of Hours Route | <None> - ‘
+-@ Firewall Profile (1) l
+- il IP Route (6)

#m Account Code (0)

%= License (74) Code Telephone Number Feature Line Group ID Add.. ‘

™ L”"":' (gz DOLXOGCOO. 001N Dial 17
2B g —
I AsRes'(ll) = @) BICOCOXKK 8N Dial 17 L

1XO0O0O000K 1N Dial 17 Edit..

#~ RAS Location Request (0) EXCCOOKX 6N Dial 17

BB Location (0) 3XCCOCOKHK 3N Dial 17

28X000KXX 28N Dial 17
55X0000000¢ 55N Dial 17
« i

5.6. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.4. To configure these settings, first navigate to User - Name in the
Navigation Pane where Name is the name of the user to be modified. In the example below, the
name of the user is Ext3040 H323. Select the SIP tab in the Details Pane. The values entered for
the SIP Name allow matching of the SIP URI for incoming calls without having to enter this
number as an explicit SIP URI for the SIP line (Section 5.4.4). The SIP Name and Contact are
set to one of the DID numbers assigned to the enterprise by Clearcom. The SIP Display Name
(Alias) parameter can optionally be configured with a descriptive name. If all calls involving this
user and a SIP Line should be considered private, then the Anonymous box may be checked to
withhold the user’s information from the network. This can also be accomplished by activating
Withhold Number on H.323 Deskphones. Click the OK to commit (not shown).

IP Offices =

#-<= Control Unit (4)

#-4p Extension (37)

=

NoUser

p3 RemoteManager
3040 Ext3040 H323

y 3041 Ext3041 H323 Contact
3042 Ext3042 H323
3043 Ext3043 Digital
3044 Ext3044 Digital

jr 3047 Ext3047 SIP

Ext3040 H323: 3040 gk - %

Telephony ‘ Forwarding ‘ DialIn ‘ Voice Recording | Button Programming | Menu Programming | Mobility | Group Membership | Announcements Personal Directory

SIP Name 5528811241
SIP Display Name (Alias) Ext3040 H323

552881241

Anonymous

HG; Reviewed:
SPOC 10/15/2014

30 of 39
ClearcomIPO9

Solution & Interoperability Test Lab Application Notes
©2014 Avaya Inc. All Rights Reserved.




5.7. Incoming Call Route

An incoming call route maps inbound DID numbers on a specific line to internal extensions, hunt
groups, short codes, etc., within the IP Office system.

In a scenario like the one used for the compliance test, only one incoming route is needed, which
allows any incoming number arriving on the SIP trunk to reach any predefined extension in IP
Office. The routing decision for the call is based on the parameters previously configured for
Call Routing Method and SIP URI (Section 5.4.4) and the users SIP Name and Contact,
already populated with the assigned Clearcom DID numbers (Section 5.6).

5.7.1. Incoming Call Route — Standard Tab

On the Standard tab of the Details pane, enter the parameters as shown below.
e Set Bearer Capacity to Any Voice.
e Set the Line Group Id to the incoming line group of the SIP line defined in Section 5.4, in
this case Line Group ID 17 was used.
e Default values can be used for all other fields.

IP Offices = 17

#- K BOOTP (3) Standard | Voice Recording { Destinations
+-4# Operator (3)
00E0Q706530F
20 System (1) - - -
11 Line B) Bearer Capability {Any Voice

2 Control Unit (4) Line Group ID 17 -
-4 Bxtension (37)
_ ‘§ User(32) Incoming Number
-3 Group (1)
J:r % Short Code (65) Incoming Sub Address

freend S 1 0
i @ ervice (0) Incoming CLI

= Incoming Call Route (2

‘ée 9 ) Locale [ ']
. ‘5 0 Priority ‘1 - Low "|

--§@ WAN Port (0)

a8 Directory (0) Tag

£ Time Profile (0)

+ @ Firewall Profile (1) Hold Music Source ‘ System Source V|

+-Jll 1P Route (6)

-l Account Code (0)

- Wgy License (74)

il Tunnel (0)

+-§3 User Rights (8)

- ARS (1)

-« RAS Location Request (0)

i Location (0)

r

a4

arm OO i OO IO s OO o R

Ring Tone Override None N
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5.7.2. Incoming Call Route — Destinations Tab

Under the Destinations tab, enter “.” for the Default VValue. This setting will allow the call to be
routed to any destination with a value on its SIP Name field, entered on the SIP tab of the User,
which matches the number present on the user part of the “To” header on the incoming INVITE

message received from Clearcom. Click OK to commit (not shown).

IP Offices |E 17 ok -8 X| v
© R BOOTP (3) Standard | Voice Recording| Destinations
#-{# Operator (3)
% DOEDOTO06530F TimeProfile Destination Fallback Extension

» Default Value a ~| -

n i
o-§  User 32)
+-#gf Group (1)
41-9% Short Code (65)
@ Service (0)
+-ally RAS (1)

=@ Incoming Call Route (2)
@ 17

@0

& WAN Port (0)

@ Directory (0)

£ Time Profile (0)
5@ Firewall Profile (1)
+-ill P Route (6)

#m Account Code (0)

% License (74)

@& Tunnel 0)
+-f15 User Rights (8)
- ARS (1)

#~ RAS Location Request (0)

&8 Location (0)

5.8. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

Save Configuration e L e S

IP Office Settings
D0ED0706530F

Configuration Reboot Mode
Merge

@ Immediate
When Free
Timed

Reboot Time

15:14

Call Barring

| OK ‘ | Cancel | Help |
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6. Clearcom SIP Trunk Services Configuration

To use Clearcom’s SIP Trunk service, a customer must request the service from Clearcom using
the established sales processes. The process can be started by contacting Clearcom via the
corporate web site at: http://www.clearcom.mx/ and requesting information.

During the signup process, Clearcom and the customer will discuss details about the preferred
method to be used to connect the customer’s enterprise network to Clearcom’s network.

Clearcom is responsible for the configuration of Clearcom SIP Services. The customer will need
to provide the public IP address used to reach the Avaya IP Office at the enterprise. In the case of
the compliance test, this is the public IP address of the Avaya IP Office WAN port (LAN2). The
customer will also need the IP addresses for the primary and the secondary public DNS servers,
these addresses can be obtained from the local ISP in Mexico.

Clearcom will provide the customer the necessary information to configure Avaya IP Office
following the steps discussed in the previous sections, including:

e SIP Trunk registration credentials (User Name, Password, etc.).

e Clearcom’s Domain Name.

e DID numbers.
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7. Verification Steps

This section provides verification steps that may be performed to verify that the solution is
configured properly.

The following steps may be used to verify the configuration:
e Verify that endpoints at the enterprise site can place calls to the PSTN.
e Verify that endpoints at the enterprise site can receive calls from the PSTN.
e Verify that users at the PSTN can end active calls to endpoints at the enterprise by
hanging up.
o Verify that endpoints at the enterprise can end active calls to PSTN users by hanging up.

7.1. IP Office System Status
The following steps can also be used to verify the configuration.

Use the Avaya IP Office System Status application to verify the state of SIP connections.
Launch the application from Start - Programs - IP Office > System Status on the PC
where IP Office Manager is installed, log in with the proper credentials.

[~ H

AVAYA IP Office System Status

Help Exit About

Online | Offline

Control Unit IP Address: ByPRERED]

Services Base TCP Port: B0l

(Lo R BT I Administrator
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State is Idle for each channel.

HG; Reviewed:
SPOC 10/15/2014

AVAYA

Help Snapshot LogOff Exit About

Feer Domain Name:

Resolved Address:

Line Number:

Number of Administered Channels:
Number of Channels in Use:
Administered Compression:
Silence Suppression:

Layer 4 Protocol:

SIP Trunk Channel Licenses:

SIP Trunk Channel Licenses in Use:

SIF Device Features:

Status | utilization Summary  Alarms

Registration

clearcom.mx
.109.42

17

20

0

G729 A, G711 A, G711 Mu

®-

off

UDFP
Unlimited
0

Channel Number Current State Time in State Codec
1 Idle 01:17:18
2 Idle 01:17:18
3 Idle 01:17:18
4 Tdle 01:17:18
5 Idle 01:17:18
6 Idle 01:17:18
7 Idle 01:17:18
8 Idle 01:17:18
9 Idle 01:17:18
10 Idle 01:17:18
11 Idle B
12 Idle 3
13 Idle 01:17:18
14 Idle 01:17:18
15 Idle 01:17:18
16 Idle 01:17:18
17 Idle 01:17:18
18 Idle 01:17:18
19 Idle 01:17:18
20 Idle 01:17:18

[ Trace ” Trace All H Pause H Ping ] Call Details
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Select the Alarms tab and verify that no alarms are active on the SIP line.

IP Office System Status

Status  Utilization Summary ~ Alarms  Registration

Alarms for Line: 17 SIP clearcom.mx

£ Trunks (4)
Link (0) Last Date Of Error Occurrences
Call Quality of Servid
TLS {0)

Error Description

Clear Clear All Print... Save As...
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7.2. Monitor

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling
messaging on the SIP trunk. Launch the application from Start = Programs - IP Office >
Monitor on the PC where Avaya IP Office Manager was installed. Click the Select Unit icon on
the taskbar and Select the IP address of the IP Office system under verification.

Iﬂ_ Avaya IP Office Sys™Monitor - [STOPPED]
File Edit Wiew Fikers Status Help

=& »8T| x|V @ ==

' RN

Start/Stop Trace Select
Trace Options  Unit

Clicking the Trace Options icon on the taskbar, selecting the SIP tab allows modifying the
threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the
color used to represent the packets in the trace can be customized by right clicking on the type of
packet and selecting the desired color.

All Settings =3
T1 | woomp | wPN | weN | soN | ssl | Jade |
aTM | Cal | DTE | ECont | FrameRelaw | GOD | H323 | Interface |
15SDM | Few/Lamp | Directon | Media | PFP | R2 | Routing | Services SIF |S_l,lstem|
Ewvents
¥ Sip [Vobose - I STUM [~ SIP Dect
Packetz
[~ SIP Reg/Opt R= [~ SIP Misc B=
[~ SIP Reg/Opt Tx [ SIP Misc Tx
[ SIPCallRx [~ Crn Motifp R«
[~ SIPCallTx [~ Crn Motify T=
I+ Sip Rx I hex IP Filter [nan.nnn.nnn. nnn)
¥ Sip Tx ™ hex |
Default AII| Clear All | Tab C|eam||| Tab sBmu| 86 ]| cancel
Save | Load File | Load Partial File| Select File |
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8. Conclusion

These Application Notes describe the configuration necessary to connect Avaya IP Office
Release 9.0 to Clearcom SIP Trunk Services. Clearcom SIP Trunk Services is a SIP-based
Voice over IP solution for customers ranging from small businesses to large enterprises. It
provides a flexible, cost-saving alternative to traditional hardwired telephony trunks. Clearcom
SIP Trunk Services passed compliance testing with the observations/limitations listed under
Section 2.2.

9. Additional References

This section references the documentation relevant to these Application Notes. Product
documentation for Avaya IP Office, including the following, is available at:
http://support.avaya.com/

[1] IP Office 9.0.3 IP500/1P500 V2 Installation, Document Number 15-601042, Issue 29f, June
13, 2014.

[2] IP Office Manager Release 9.0.3, Document Number 15-601011, Issue 9.0.3, May 8, 2014.

[3] Using System Status, Document Number 15-601758, Issue 09¢, August 15, 2013.

[4] IP Office Release 9.0.3 Administering Voicemail Pro, Document Number 15-601063, Issue
9.0c, April 24, 2014.

[5] Using IP Office System Monitor, Document Number 15-601019, Issue 05e, February 5, 2014.

Additional Avaya IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/
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full title name and filename, located in the lower right corner, directly to the Avaya
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